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Introduction 
 
A MIDI Foot Controller (MFC) is a device used to control musical equipment using a MIDI connection.  
These foot controllers are commonly used by guitarists to select sounds and effects in digital guitar 
processors.  MFCs have button footswitches with built-in and/or externally connected pedals. 
 

GM Arts Firmware 
This firmware allows you to set any footswitch to operate any function on any of the currently available BJ 
Devices TB MIDI Foot Controllers.  Multiple pages of footswitches are available, and footswitches can 
operate dual functions in advanced mode. 
 

 There are 16 banks, each with 10 patches 

 There are 10 effects, each capable of sending 2 x CC messages (or more in advanced mode) 

 An additional 4 optional automatic effects 

 All pedals and relays are supported 

 Effects and other settings can be changed on a per-patch basis in advanced mode 

 Supports Fractal Audio Axe-FX II and Axe-FX III models 
 
This manual describes GM Arts firmware version 4.0 for the BJ Devices MIDI Foot Controllers. 
 

MIDI Messages 
 
There are many types of MIDI messages that the MFC can send to connected equipment, but the messages 
most commonly used are: 
 

 PROGRAM CHANGE (PC) is used to change patches on a digital processor.  For example, this might 
change from a clean Fender patch to an overdriven Marshall patch. 
 

 CONTROL CHANGE (CC) is used to modify the sound of a patch.  For example, a footswitch could 
turn an effect such as reverb off and on.  Likewise, a pedal could control the volume level of a 
patch. 

 
A less common message sent by MFCs is a SYSTEM EXCLUSIVE, used to control very specific settings.  NRPN 
messages (which are actually a sequence of CC messages) can also control specific settings.  In all cases, 
you will need to consult the documentation for your MIDI equipment to set up your MFC. 
 
In Advanced mode, you can send one or more MIDI messages of any type from any footswitch. 
 

What's Included 
 
Included files:  

• A “hex” firmware file for each of the BJ Devices MFC models 
• Several sample “eep” settings files to load into your MFC 
• A PC editor application to create, edit and backup your own eep settings files 
• The editor includes a built-in MFC emulator allowing you to test settings from your PC 
• This manual and tutorials for main MFC functions 

 



The editor installation should download Microsoft .NET framework version 4.5 if you don't already have it, 
but if you have problems, you can download it here: 
 https://www.microsoft.com/en-au/download/details.aspx?id=30653 
 

Features 
 
This firmware has two modes of operation:  

• Basic operation: for a simple MFC, but still with many features 
• Advanced options: for sophisticated MFC functions, highly configurable 

 
You can select a mode from the toolbar.  It is recommended to start with basic operation then add 

advanced features if necessary. Here's a summary of the main features: 

 
Basic operation has: 
 

• Compatibility with any of the current BJ Devices MFC models:  TB-12, TB-11P, TB-8, TB-6P and TB-5. 
• You can customise your own footswitch layout - any footswitch can do whatever you want. 
• There are multiple footswitch pages available, allowing effectively up to 36 footswitches on the TB-

12 for example.  The TB-12 and TB-11P have 3 pages, other models have 4 pages available. 
• 16 banks labelled "A" to "P", each has 10 patches available (total 160 patches) 
• 10 footswitch effects including Tap, plus up to 4 additional automated effects 
• Tap can switch on selected effects after a defined number of presses 
• 4 different effect footswitch types, including toggle and momentary 
• Effect footswitches can send 2 messages, which can be CC messages and/or setting relay states 
• CC messages can have any off or on value, allowing reverse operation, or switching between 

different levels 
• Effects can belong to any of 7 groups, to ensure only one effect is on in the same group 
• Relay toggle footswitches support all 4 built-in relays 
• Supports on-board and external pedals, with optional effect switching at heel-down position 
• Effects can switch pedals between different settings (eg to switch a pedal between volume and 

wah) 
• Built-in pedal calibration and emergency disable for pedal faults 
• Edit program numbers and their initial effect states on the MFC 
• Can backtrack patches, optionally with their effect states and bank changes 
• Supports Axe-FX II functions: tuner, patch names, effect states, tap tempo with tempo backtracking 

 
Advanced options add these features: 
 

• Additional footswitch types to select any specific patch, set any relay combination, and to send any 
MIDI message(s) for almost unlimited effects or any other purpose. 

• Footswitches can have a 2nd function.  For example: toggle between 2 patches, or select a bank with 
a short press or go to a different page with a long press. 

• Send additional messages and set relay states with program changes 
• Set the order of events for program changes 
• 1000 bytes available for custom Overrides and Library book messages 
• Up to 250 library books, each of which can contain one or more MIDI messages such as system 

exclusives, CC messages, and can also include special commands to control the MFC.  Library book 
messages can be sent with patch selections, from effect changes and with the "Send MIDI" 
footswitch. 

https://www.microsoft.com/en-au/download/details.aspx?id=30653


• Up to 250 overrides, depending on complexity. For example, an override could be: "in patches A3, 
B4 and H2, effect footswitch 3 will control a booster instead of an overdrive". 

• Library books and Overrides can be used in combination to send messages on different MIDI 
channels, send different messages to multiple devices, etc. 

• MFC patch buttons can send MIDI PC messages (as usual), or CC messages (useful for Axe-FX scenes) 
or both and more with library messages. 

• … and more 
 
 

  



Quick Start & Connections 
 

Downloads 
 
Download the firmware and editor from http://www.gmarts.org/tb/   

 
This is a ZIP file, so you will need to use (or download) a program to extract the files from this download.  
 
There is a folder for your TB model containing firmware and sample settings files.  Another folder 
contains the editor installation files.  Run the file "setup.exe" to install the Editor. You may see warnings 
about "unknown publisher" because I don't use a certificate at this stage. 

 

Loading Firmware and Settings 
 
There are 2 files that need to be loaded into your BJ Devices MFC:  

 The firmware is a file that ends with ".hex".  Make sure to choose the firmware that matches your 
MFC model.  Firmware controls how the MFC works. You can always go back to BJ Devices factory 
firmware if you wish. 

 Settings for the MFC are in a file ending with ".eep". A sample file is included. You can use the PC 
editor to create and modify your own settings files, or start with one of the sample files. 

 
Instructions for loading these files into your MFC can be found here: 
 http://bjdevices.com/wiki/doku.php?id=user_guide#firmware_update 
 

Connections 
 
1. Connect a MIDI cable from your MFC MIDI OUT to your musical device's MIDI IN. 
2. If you have an Axe-FX II and wish to use those features on you MFC, connect another MIDI cable 

from your Axe-FX MIDI OUT to the MFC MIDI IN. Make sure that your Axe-FX is set to send both 
tuner and tap MIDI messages. 

3. Optionally connect one or both pedals to the MFC. 
4. Then connect power to your MFC. 

 

 
You can now use your MFC! 

  

http://www.gmarts.org/tb/
http://bjdevices.com/wiki/doku.php?id=user_guide#firmware_update


MFC Display 
 
The main display elements are shown below.  Use the editor to customise bank names, effect names 
and abbreviations. 
 

 
 
 

MIDI OUT Options 
 
When you first power on the MFC, it is set to send MIDI out via the standard DIN socket on the back of 
the MFC, labelled "MIDI OUT". 
 
You can press the UP button on top of the MFC to toggle between sending MIDI OUT via USB or the DIN 
socket. 
 
If sending MIDI output via USB, you will need to follow the instructions from the factory firmware 
manual to receive MIDI on your computer.  They are reprinted here: 
 

BJ Devices TB-series midi controllers have an USB interface for connection to a computer, but are not 
PC-compatible MIDI devices. In order to use the controller as a MIDI device via USB, follow these steps: 
 
1. Install serial to midi converter Hailess MIDI  http://projectgus.github.io/hairless-midiserial/ 
 
2. For Windows install virtual MIDI port LOOPMidi(not needed for MAC): 

http://www.tobias-erichsen.de/software/loopmidi.html 
 

3. For MacOs enable the “IAC” virtual MIDI port. Applications→Utilities→“Audio MIDI Setup”→“Show 
MIDI Window”→“IAC Driver”.  Check the “Device is online” box in the dialog that appears. 
 

4. Install USB-COM driver (in most cases this installation starts automatically) 
http://www.ftdichip.com/Drivers/VCP.html 
 

5. Run Hairless MIDI↔Serial Bridge, then … 
- choose COM port which is according TB-series controller COM port 
- assign COM port to midi OUT device LOOPMidi(or IAC for MacOs) 
- set baud rate to 56000 

  

http://projectgus.github.io/hairless-midiserial/
http://www.tobias-erichsen.de/software/loopmidi.html
http://www.ftdichip.com/Drivers/VCP.html


Using the Editor - Basic Mode 
 
When you first open the editor, you'll see this screen.  Select your MFC model to make new settings, or 
click on "Open File" to continue work on settings you've previously saved. 
 

 
 
 
 
The main features of the editor are at the top of the window: 
 

 
 
 

  



Footswitches Tab 
 
The first tab is [Footswitches] which allows you to assign a function to each footswitch.  Buttons are 
shown for each of the footswitches available on your MFC model.  When you start a new file, all 
footswitches are set to "None".  Click the footswitch buttons to assign functions.  Or click [Clear All] to 
set all footswitches back to "None" on the current page. 
 
Some MFC models have an on-board pedal with a footswitch under the toe end of the pedal.  For those 
models, you'll see a button labelled "Pedal". This refers to the footswitch under the pedal, not the pedal 
itself. 
 
Here's an example with functions assigned to all footswitches: 
 

 
 
 
Click one of the buttons to start, and you'll see a popup menu giving you a choice between 4 different 
footswitch types: 
 

 PATCH - allows you to choose a patch from 0 to 9 in the current bank 

 EFFECT - allows you to set a footswitch to control effect number 1 to 9, or Tap 

 BANK - has various choices to change the current bank 

 PAGE - is used to switch between different footswitch pages 
 



 
 
See the Footswitch Tutorial for examples of how to set up your footswitches. 
 

Footswitch Functions 
 
The popup menu won’t let you to make invalid selections, so you'll see some selections disabled as you 
assign footswitch functions.  For example, you can’t put the same function on more than one footswitch on 
the same page.  There's no point in having 2 buttons on the same page doing the same thing. 
 
However, you can set up each page independently, so for example, you can have a Tap footswitch on every 
page if you wish. 
 

  



Patch Footswitches 
 
PATCH 0 to PATCH 9 
 
These simply select a patch in the current bank.  So if the current bank is "D" and you select patch number 
7, you are selecting MFC patch D7.  On your MFC, a LED lights red to show the current patch selection. 
 
A patch LED will flash if pressing it will change the sound in some way: 

 If you have switched one or more effects in the patch off and on, pressing the patch footswitch will 
instantly reset the patch 

 If you've changed banks, the patch LED flashes alternately red and yellow to indicate that pressing 
the patch footswitch will select the same patch number in the new bank 

 
 
BACKTRACK 
 
Once patches have been selected, this allows you to switch between the last two patches used.  It can 
optionally apply any effect changes (and even tap tempo for Axe-FX users).  This is useful for switching 
between rhythm and solo sounds. 
 
 
PATCH UP and PATCH DOWN 
 
These footswitches select the next higher and lower patch.  Normally these patches go through all 
available patches within any bank range you've set.  For example, if you use the default of all available 
banks (from A to P), then patch up will start at A0, then A1, A2, A3, …, A8, A9, B0, B1, …, P8, P9, then wrap 
around to A0, etc. 
 
There is an option on the "MFC Patches" tab to limit patch up/down to a range within the current bank.  
For example, if you set the patch range from 3 to 7, and the current bank is "B", then patch up will start 
from B3, then B4, B4, B6, B7, then wrap around to B3, etc. 
 
 
 

  



Effect Footswitches 
 
EFFECT 1 to EFFECT 9 
 
These footswitches turn effects off and on.  Effect footswitches can be several different types, including 
toggle (stompbox-style press once for ON, press again for OFF), and momentary (press for ON, release for 
OFF). 
 
TAP 
 
This is used to set tap tempo.  You can also configure tap to turn on additional Tap Effects after a preset 
number of Tap presses after a patch change. 
 
Effect details and options are set on the "Effects" tab. 
 

Relay Footswitches 
 
RELAY 1 to RELAY 4 
 
Relay footswitches simply toggle one of the inbuilt relays off and on.  These are handy if you use the relays 
to control external equipment such as amp channels and effects.  Relays are normally not changed when 
selecting a new patch (unless you use patch change settings in advanced mode for this purpose). 
 
If you need more complex control of relays, such as switching between different combinations, operating 
them as momentary controls, or using them in effect groups, these can all be done with relay settings in an 
effect. 

 

Bank Footswitches 
 
Banks are labelled A, B, C, … though to  P.  When you select a patch number on your MFC, it is combined 
with the current bank. For example, if the current bank is D and you select patch number 7, you are 
selecting MFC patch D7.  There are 16 banks and there are several options that allow you to change the 
current bank. 
 
BANK UP and BANK DOWN 
 
These select the next higher or lower bank.  Bank numbers "wrap around".  For example, if you're currently 
using Bank A, then BANK UP goes to Bank B, while BANK DOWN wraps around to Bank P. 
 
BANK+1 TOGGLE 
 
This is useful if you only need 2 banks.  You can do this with one footswitch instead of needing 2 
footswitches for BANK UP and BANK DOWN.  Press once to go bank up (a yellow LED shows when this is 
on), and press again to go bank down.  Because this function has a LED indicator, you cannot also use a 
Page LED on the same footswitch. 
 
  



BANK NOW 
 
Once you've selected a patch, you can use this footswitch to select the bank of the current patch.   So if 
you've made bank changes since selecting your patch, this function returns to the current patch's bank. 
 
BANK SELECT - A to P 
 
These simply select a particular bank, from Bank A through to Bank P.  The current bank shows with a 
yellow LED. 
 
Bank details and options are set on the "MFC Patches" tab. 
 

Page Footswitches 
 
You can use pages to go between different footswitch pages on your MFC.  Make sure you have page 
footswitches that allow you to get back to where you came from! 
 
Page options include a specific page, previous page, page up, page down and page select. 
 

Page LEDs 
 
A current Page LED indicator can be assigned to footswitches that don't already use a LED, such as Page 
change footswitches. 
 
You can set any of the available colours: red, green or yellow, and they can be set to flash or not. 
 
FOR MODELS TB-11P and TB-6P 
 
These models have an on-board pedal.  If you assign a page LED to the pedal, you can select additional 
colours.  Also, the page indicator will move up and down the pedal to indicate the current pedal position! 
 
If the very top pedal LED is used by the under-pedal footswitch on any page, then the pedal position will be 
shown on the lower pedal LED pairs. Otherwise, all pedal LEDs will show the pedal position. 
 

Making Footswitches Work 
 
Once you've set what you want your footswitches to do, you'll need to make various MIDI settings to 
control your MIDI equipment.  The next sections take you through remaining tabs in the editor with sample 
settings. 

  



MIDI Tab 
 
You will need to set the MIDI channel to the same channel used by your MIDI device.  This will commonly 
be channel 1. 
 
You can also set MIDI program banks here.  For example, the Axe-FX uses MSB bank 0 for patches in what 
it calls "Bank A".  MSB bank 1 is used for Axe-FX "Bank B", and so on.  MSB and LSB banks are used in 
combination with the MIDI Program number set on the [MFC Patches] tab to allow you to select a large 
number of different patches. 
 
MSB and LSB are MIDI message Program Banks and are NOT the same as MFC patch banks "A" to "P".  
Advanced mode gives options to use different MIDI channels, Program Banks and message types, but for 
now, we'll continue with Basic mode. 
 

 
 

 
 
 

  



For Axe-FX Owners 
 
Select your Axe-FX model from the drop-down list and select the options you want.  
 
The Axe-FX tuner will show automatically on the bottom row of the MFC display whenever the tuner is on, 
even if you turn it on from the Axe-FX itself.  
 
Flash Tap Tempo shows the Axe-FX tempo on the Tap LED once a tempo has been set if you're using Tap 
Effects, or all the time if you've disabled Tap Effects on the Effects tab.  
 
Tempo Backtracking is used when you backtrack to a patch that had a tempo set.  It will set the same 
tempo for you automatically.  
 
Get Block States is used to display Axe-FX effect states on the MFC when you select a patch. Please also 
read the section on Getting Effect States from the Axe-FX. This option is good for simple effect off/on 
patches, but will not suit more sophisticated effect options.  
 
Axe-FX patch names (and/or scene names for Axe-FX III owners) can be shown with patch selections, 
subject to space limitations on the MFC display. The MFC patch will briefly show on the display and will be 
replaced by the Axe-FX name when received.  
 
There are several tips for Axe-FX owners in this section. 
 

MFC Patches Tab 
 
The first thing to notice on this tab is the horizontal slider.  Use this to select any of the 160 MFC patches.  
The grey shaded area shows which settings are affected by the slider.  Other settings on this page apply to 
all patches. 
 
There are 160 MFC patches are split into 16 banks each with 10 patches.  For example, MFC patch A3 
means patch 3 in Bank A.  Each MFC patch has a bank from A to P, and a number for 0 to 9.  So patches are 
labelled in this sequence: 
 A0, A1, A2, A3, …, A8, A9, B0, B1, B2, …, B9, C1, C2, C3, …, P8, P9 
 
The patch you send is determined by the bank that has already been selected.  The patch footswitch you 
press selects that patch number in the current bank.  Here's an example: 
 

 
 
 
Each MFC patch can send a MIDI message to select any program on a connected device.  The example 
below shows that MFC Patch A7 will select MIDI program 12.  



 

 
 

 
You also use this page to set the initial states of effects for each patch.  There is more detail later on how 
these settings can be used to give you full control over how effects are set when selecting a patch. 
 
 
TIPS 
 
Firstly, you don't need to set up all 160 patches.  You only need settings for the patches you will use.  For 
example, if you've set your footswitches to select patches 1, 2, 3 and 4, and you'll only be using banks A 
and B, then the only patches you need to set up are: 
 A1, A2, A3, A4, B1, B2, B3 and B4. 
 
You can drag the slider to quickly get close to any patch, then use the left and right arrows to go down or 
up one patch at a time.  You can click either side of the slider to go down and up one bank at a time. 
 
You can also edit MIDI programs and initial effect states on the MFC itself, without using the PC editor.  So 
you can choose to NOT save them in the settings file by un-checking "Save Program Numbers and Effects".  
That way, you don't need to keep editor and MFC settings synchronised.  It will probably be easier to use 
the editor for the first time you set up your MFC patches. 
 
OTHER MFC PATCH SETTINGS 
 
The "MFC Patches" tab also allows you to set bank names.  Remember, if you click on the scroll bar to the 
left or right of the slider, you will move one bank at a time, making it easy to scroll through each bank.  



 
Use the dropdown list to select how patches are shown on the MFC. You can choose:  

 MFC Bank & Patch, for example: Patch C4 

 MIDI Program Number, for example: Prog: 017 

 Axe-FX Program Number, for example: Axe-FX 012 

 MFC Patch & Axe-FX Name, for example: C4 RockSolo 
 
If you have Axe-FX options set to show Axe-FX program names, the Axe-FX patch name will replace any 
these selections when and if it is received.  
 
Check “Show MIDI program numbers as 1-based” to show MIDI program numbers as 1 to 128 in both the 
editor and on the MFC. Otherwise, program numbers will show as 0 to 127. Match this setting to the way 
your connected equipment shows its program numbers. 
 
 
BACKTRACKING 
 
Backtracking is a powerful feature that allows you to toggle between the current and last patch, optionally 
with their effect states including Tap FX and even Tap Tempo if you have an Axe-FX.  
 
You can even use backtrack to switch between different effects on the same patch by selecting the current 
patch again and making different effect selections.  
 
Backtracking can also restore pedal positions from the previous patch. 
 
Normally you would allow backtracking between different banks, but if you use banks for different 
purposes such as different guitars or different MIDI equipment, you might want to disable this option. 
 
 
BANK AND PATCH RANGES 
 
Bank Up and Bank Down footswitches are commonly used to access the different patch banks on your 
MFC.  Normally these would give you access to all 16 banks from "A" to "P", however, you can restrict this 
range if you wish, to whatever you want.  You can still use Bank Select footswitches to select any bank, 
even if it's outside of the bank range you set here. 
 
Likewise, Patch Up and Patch Down footswitches normally work with all patches in the bank range, 
however, you can restrict their range within the current bank if you wish. 
  



Effects Tab 
 
The word "state" is used often in relation to effects. It simply means whether they are OFF or ON.  In 
addition to effects, the BJ Devices MFCs have 4 inbuilt relays that can have their states set to OFF or ON.  
Relays can be used to control external equipment that use footswitches, such as channel switching on an 
amplifier.  
 
Footswitch effect numbers link directly through to effects numbered on the Effects tab: 
 

 
 
 

Here's what the Effects tab looks like: 
 

 
 
 
  



MIDI CC SETTINGS 
 
MIDI CC messages are sent to turn your effects off and on.  Some manufacturers call these "IAs" but they 
are fully implemented in this firmware and can do much more than just off and on. Each effect footswitch 
can send:  

 2 x CC messages, or 

 1 x CC message and set any or all relay states 

 Even more in Advanced mode 
 
A CC message has a number and a value: 

 The number defines what you want to control. You need to match these numbers with your MIDI 
equipment. For example, you might have your overdrive effect responding to CC number 25, and a 
chorus effect responding to CC number 50, etc. 

 The value controls what happens to that effect. The most common settings are 0 for OFF and 127 
for ON. 

 
This firmware allows you to set any OFF or ON value you wish. This means:  

 You can use the standard 0 for OFF, 127 for ON 

 You can reverse OFF and ON values for reverse operation. For example, you might use an equaliser 
effect for rhythm playing. This equaliser maybe lowers the volume and cuts some mids.  Reversing 
the values allows the MFC to display ON while you're soloing with the equaliser OFF. 

 You might want the effect to switch between 2 different values. For example, this could be used for 
a boost effect by switching volume levels, or it could control the level of reverb to switch between a 
surf reverb and ambient reverb. It could switch between two different speeds for a rotary effect, 
and so on. 

 You might want to switch between 2 scenes on the Axe-FX.  For example, scene 1 needs a value of 
0, and scene 4 needs a value of 3 (the values are one less than the scene number). 

 
 
EFFECT NAMES AND ABBREVIATIONS 
 
You can give each effect a short name (up to 5 characters). This name will display and the MFC when you 
press the effect footswitch, also showing whether it's off or on.  Effect names and abbreviations are shown 
on the MFC display.  
 

Footswitch Types 
 
TOGGLE 
 
This is the most common type of effect footswitch. It works like a typical stompbox.  Press once to turn on, 
press again to turn off. 
  
 
PERSISTENT TOGGLE 
 
This is the same as a toggle, but it "remembers" its current state when you go to your next patch. For 
example, if you turn on a persistent chorus effect, then change patches, chorus will still be on, even if it 
would normally be off in the new patch.  
 
 
  



MOMENTARY 
 
These effects are turned ON when the footswitch is pressed.  Press to turn ON, release to turn OFF.  You 
can reverse this operation if you wish by setting the initial state to ON - this is done on the MFC Patches 
tab.  
 
 
SELECT 
 
These footswitches are press to turn ON. If you press again, the ON messages will be sent again and the 
effect will remain on.  These are for situations where there is an ON message to make a change, but no off 
message, such as selecting scenes on the Axe-FX, or selecting modes for a looper.  
 
You would often have Select footswitches in a group. Only one effect can be on at the same time in a 
group. So if you have 4 footswitches in the same group set for scenes 1, 2, 3 and 4, the currently selected 
scene will show, and other footswitches in the group will be off.  Select effects can only be turned OFF 
within a group, or by selecting a new patch that has the effect's initial state set off.  
 
 
HELD DOWN TOGGLE ACTS AS MOMENTARY 
 
Just while we're looking at footswitch types, there's an option on the page that affects ALL effects that 
have toggle footswitch types, including persistent toggles.  If you select the option "Held down toggle acts 
as momentary" then 
 

 If you press and release the switch normally, it still works as a toggle:  press once to turn ON, press 
again to turn OFF. 

 If you press and hold the switch for 1 second or more, it behaves as a momentary footswitch:  press 
to turn ON, hold down, then release to turn OFF. 

 If the effect is already ON, press to turn OFF, hold down, then release to turn back ON. 
 

Other Footswitch Options 
 
GROUPS 
 
Effects can belong to a group. There are 7 groups available. When you turn an effect ON in a group, any 
other effects in the same group are turned OFF first. So groups are used when you only want one effect on 
at a time. Groups can be used by Toggle, Persistent Toggle and Select effect types, but not for Momentary 
effects.  
 
 
PEDAL X/Y 
 
You can use effects to switch a pedal between two different settings, such as between volume and wah 
control. If you use the X/Y settings, the pedal will use X settings when the effect is off and Y settings when 
the effect is on.  
 
It's recommended to use only one effect to control X/Y switching for the same pedal - otherwise it will get 
confusing! Pedal X/Y switching is ideal for when you use the same pedal for different purposes. You can 
read more about pedal X and Y settings below.  
  



SENDING INITIAL EFFECT STATE WITH PATCH CHANGE 
 
Check " Send initial effect state with patch change " to guarantee that your initial effect states set on the 
MFC Patches tab will be set when you select a patch. Leave this unchecked if you don't need to force an 
effect off or on when you select a patch.  
 
 
RELAYS 
 
Each effect can send 2 x CC messages, or a CC message and set relay states. This example shows the relay 
settings available: 
 

 
 
 
TAP TEMPO & TAP EFFECTS 
 
Use the slider to select each effect. After effect 9, you will find settings for Tap and Tap FX.  
 
Tap is a momentary footswitch and should be set for the CC number your equipment uses to set its tap 
tempo. Normally only an ON value is required, often with a value of 127. You could use the second CC 
message for an additional hold effect, because this is unlikely to affect tap tempo. I use mine for a long 
repeat effect.  
 
Tap Effects are additional effects that you can turn on after a preset number of tap presses after a patch 
change.  For example, you can set this so that after 2 tap presses, it turns on your delay effect.  When you 
select Tap Effects, you will see an option to set the number of tap presses. 



 
Tap Effects are a Select type of footswitch. It is turned on after the preset number of tap presses, and can 
be turned off only within a group (by selecting another effect in the same group) or by selecting a patch. 
You can disable Tap Effects by setting the number of Tap presses to "Off".  
 
 
HEEL EFFECTS 
 
Heel effects can be used to turn an effect on when the pedal is in use, and off when the pedal is off in the 
heel down position. You can buy pedals with a spring return that parks them in the heel down position 
when you lift your foot from the pedal. This way, you don't need to use a separate effect footswitch; you 
simply operate the pedal when you need the effect.  
 
Heel effects are ideal for a pedal that you only use for a certain effect such as wah or whammy, and 
otherwise left off.  
 
You'll see in the next section that pedals have X and Y settings to allow multiple use of the same pedal. 
Heel effects work from X settings only.  
 
A common example is to have a heel effect turn on a wah effect that you control with the pedal. When the 
pedal is parked in its heel-down position, the wah effect is off.  
 
A creative example is to have a pedal set as volume, and use the heel effect to turn a tuner ON at the heel 
down position. That way, you're automatically muted when tuning and you don't need to use a separate 
effect footswitch for the tuner.  This is done by reversing the off and on values for the tuner, because you 
want the tuner ON when the heel effect is OFF and vice-versa. 
 
 
AXE-FX III BLOCKS 
 
If you've chosen an Axe-FX III model on the MIDI tab, you'll see an additional option on the Effects tab for 
Axe-FX III block.  This is used to synchronise effect states on the MFC with Axe-FX blocks in the patch 
you've selected.  There is more detail for Axe-FX owners in this section.  Very briefly: 
 

 There are 2 ways to synchronise effects states between the MFC and Axe-FX III:  "Send initial effect 
state with patch change" or set the Axe-FX II block and turn on "Get block states" on the MIDI tab.  
You would not normally use both methods for the same effect. 
 

 Setting an Axe-FX III block prevents you sending a 2nd CC message (or setting relay states) in basic 
mode.  You can use library books to send as many effect messages as you like in Advanced mode. 
 

 Setting effect blocks only applies to the Axe-FX III which uses a different method to notify block 
states.  This is done automatically for Axe-FX II owners. 

 
 
 
 



  



Pedals Tab 
 
Your MFC has connections for 2 external pedals, and some models have an on-board pedal as well.  Before 
using the pedals, they should be calibrated on the MFC to ensure they control effects over their full range.  
See the MFC Setup section for more information on this.  
 
PEDAL CONTROLLERS 
 
There are 2 groups of settings available for each pedal, called X settings and Y settings.  When you select a 
patch, X settings are used by default.  If set up, turning an effect on can switch a pedal to Y settings.  
 
The most important setting is the CC number. This must be matched to the CC number used by your 
connected device to be able to control your effects, such as volume and wah.  That may be all you need, 
but you can also set a specific reset value and use options to reset the pedal if necessary:  
 

 Send reset with patch selection:  This can be used to ensure that the pedal starts at the same level 
whenever you select a patch. 

 Send last pedal value with patch:  This is useful for maintaining the current setting in a new patch. 
For example if you have your volume set half-way, the same value will be sent with a new patch to 
avoid a sudden volume change. 

 Send reset if disabling pedal:  There is a pedal disable function you can use quickly in a live situation 
if your pedal fails. This setting is used to send the reset value if you disable the pedal. 

 Send reset if switching X/Y settings:  This can be used to make sure the pedal has the reset value 
when being turned off to use the other pedal settings. 

 
BS-2 UP/DOWN FOOTSWITCHES 
 
BJ-Devices also sell a BS-2 up/down dual footswitch which is supported by GM Arts firmware.  Select the 
type of device connected to each pedal socket on you MFC: either a pedal controller or BS-2. 
 
The BS-2 footswitches can control 

 Bank Up/Down (within bank limits), or 

 Patch Up/Down (within patch limits) 

 Page Up/Down (for pages with footswitches) 

 More in Advanced Mode 
 



 
 

Or with BS-2 selected: 
 

 
 



For pedal controllers, you can set a percentage of padding under the toe and heel. Padding is how much 
sweep you want with no further change to the pedal value. A small value here ensures you will always be 
able to get the minimum and maximum values at each end of the pedal's travel.  You might use a higher 
number here if you have an under-pedal footswitch to allow you to get the full pedal value without 
activating the footswitch.  
 

File Menu 
 
File > New gives you the same option as when you start the program, to select your MFC model. 
 
File > Save saves your settings in a file with an extension of ".eep".  If you're using Advanced mode with 
descriptions for overrides and/or library books, a second file will also be saved with an extension of ".nfo".  
So if you need to move your setting files to a new folder, make sure you keep these files together.  
Likewise, if you wish to rename your .eep file, also rename the .nfo file. 
 
Other file menu items work the same as all Windows applications. 
 
File options are also shown at the left of the toolbar.  Hold your mouse pointer over an icon to see what it 
does.  There are toolbar icons for a new file, open a file, save settings and "save as". 
 

Using the Emulator 
 
You can click on the green arrow on the toolbar to run the emulator.  Select your music device if you have 
it connected, or you can still view MIDI messages if you leave it as "Microsoft MIDI Mapper".  
 
The emulator shows the button layout of your MFC and sends MIDI messages.  It also shows what 
messages are being sent with a text description. It does not receive MIDI, so it won't retrieve Axe-FX 
information like the actual MFC. It is a useful tool to test your settings, and designed short and wide to fit 
under your Axe-Edit window! 
 

 
 
The purpose of the Emulator is to make sure the footswitch layout works as you expect, and to check that 
the right MIDI messages are being sent. 
 
Simply click on the footswitch labels and drag the pedal sliders to operate the emulator. 
 
  



MFC Setup 
 

You can edit some setting changes directly on your MFC, without using the editor. 
 

MFC Patches 
 
On the MFC after you have selected a patch, press [SETUP] and you will see the MIDI program number for 
your current MFC patch.  Use the [LEFT] and [RIGHT] buttons to change the MIDI program number.  
 
Press [DOWN] to go to the next setup page for initial effect states.  This will show a number 1 to 9 for 
effects that are initially on, or a "." if they are off.  Use [LEFT] and [RIGHT] to move the cursor under the 
effect you want to change, then press any footswitch to toggle it off and on. 
 
Pressing [DOWN] further will take you to pedal calibration settings (see next section).   When you have 
settings you want, press [OK].  Or to exit without saving settings, press [NO].  
 
TIP: If you're managing your patch numbers and effect states on the MFC, you can exclude them from the 
PC Editor by unchecking "Save Program Numbers and FX" on the [MFC Patches] tab  That way you won't 
lose settings by not having them synchronised between the MFC and the editor.  
 

Pedal Calibration 
 
This should be done the first time you use the MFC and whenever you change pedals.  
 
On the MFC, press [SETUP] then use [UP] and [DOWN] to select calibration for each of your pedals.  
 
Make sure the pedal is connected and press [RIGHT] to start. You'll first see the current minimum and 
maximum pedal values, then the current pedal value. Sweep the pedal a few times from minimum to 
maximum to set its range. When finished, press [LEFT] to return. Repeat for the other pedal(s) if necessary, 
then save your settings with [OK], or press [NO] to exit without saving.  
 

Pedal Failures 
 
Pedals are subject to failure or temperamental behaviour due to scratchy pots, mechanical problems and 
connecting cable faults. The quick fix to disable all pedals is to press [OK] twice - you could even do this in 
the middle of a solo!  
 
HOW IT WORKS 
 
Pressing [OK] displays a screen to disable ALL pedals. You can press [UP] and [DOWN] to scroll through 
options to disable just one pedal.  
 
Press [OK] again to disable the selected pedal(s).  If configured, this will also send a reset value for the 
pedal(s), for example, maximum volume for a faulty volume pedal.  If pedals are not disabled, they will be 
re-enabled.  This is a temporary change only - configured settings will be used next time the MFC is 
restarted.  
 
Press [NO] to exit this screen without making changes.  



Summary - Basic Mode 
 
Basic mode may give everything you need, so if you have your MFC working the way you want, you don't 
even need to read further.  I'd certainly recommend that you get to know basic mode well before adding 
the power of advanced mode features. 
 
 

Advanced Mode 

 
Advanced mode adds powerful and sophisticated options to really get your MFC singing and dancing!  But 
remember that ease of use is paramount in a live situation, so footswitch layout is always important. 
 
Select "Advanced Options" at the top of the editor window and you'll see new tabs added.  Many sliders 
have additional positions for override settings, and there are more options on the some tabs. 
 

 
 

 
 



Features added in advanced mode are: 

 Many footswitches can have 2 functions 

 Additional footswitch types (send a specific patch, send MIDI, up/down, set relays) 

 A Stepper tab for footswitches that step between different values 

 MFC patch buttons can send MIDI PC messages (as usual), or CC messages (useful for Axe-FX 
scenes) or both and more with library messages. 

 A Patch Select tab to send messages after a patch selection, set relays, and various other settings 

 A Library tab to create and edit books which can contain one or more MIDI messages of any kind, as 
well as commands to control the MFC. 

 Library books can be used by Effects, with Patch Selection, and from the "Send MIDI" footswitch 

 You can set the pedal range on the Pedals tab 

 You can make override settings on these tabs: MIDI, Effects, Pedals and Patch Select. 

 An Overrides tab allows you to use override settings for selected patches 
 
These features are described below. 
 
 

Footswitch Tab 
 
There are additional footswitch types: 

 On the Patch menu: a "Select …" footswitch can select a specific patch (both bank and patch), such 
as "J3" 

 On the Effect menu: a "Set Relays …" footswitch allows you to set any combination of relay states 

 On the Effect menu: a "Send MIDI" footswitch can send any library book (which can be one or more 
MIDI messages), and can optionally send another library book using toggle or momentary 
footswitch types 

 
Many footswitches can have a second function.  Once you have assigned a main function to a footswitch, 
advanced mode allows: 

 A Patch footswitch can have a 2nd patch number so you can toggle between 2 patches 

 Patch and Bank footswitches can "also go to …" another page 

 Patch and Bank footswitches can have "and hold for …" options to always activate the main 
function, and optionally go to another page if you hold down the footswitch. 

 Patch, Bank and Page footswitches can have "or hold for …" options to set a bank or page.  So a 
quick press and release activates the main function, or you hold the footswitch down for the 2nd 
function instead. 

 
While you still cannot duplicate the same main function on the same page, you CAN duplicate 2nd bank 
and page functions.  For example, you could use page 1 for your patch footswitches, all with the option to 
go to Page 2 if the footswitch is held down.  Page 2 could be set up with your effect selections. 
 
A brief explanation is shown when these options are used.  See the Footswitch Tutorial for examples and 
more information on footswitches with 2 functions. 
 
 



 
 
 
 

ABOUT 2ND PATCHES 

You can assign 1st and 2nd patches to a footswitch.  When the first patch is active the LED lights red; when 

the 2nd patch is active the LED is yellow.  In normal operation, the first time you use the footswitch, you 

select the first patch, then each time you use the footswitch it toggles between the 1st and 2nd patches. 

Just like Basic mode, if you change some effect states, the patch LED flashes to indicate that the next press 

of the patch footswitch will reset the current patch. 

There are occasions when you may need to press the patch footswitch twice to get the patch you want.  If 

you double-click a footswitch (within about a second, so there's no rush), the first press is ignored for 

backtracking purposes, so backtracking works as you expect. 

Also note that (like Basic mode) a patch LED will flash alternately red and yellow if you select a different 

bank.  Regardless of whether you're currently using a 1st or 2nd patch, pressing a patch footswitch will 

always select the 1st patch in a new bank. 

 

  



SET RELAYS 

This option simply allows a footswitch to select any combination of relay states.  If you need to also set 

relay states with patch changes, use the [Patch Select] tab. 

 

 

SEND MIDI FOOTSWITCHES 

Send MIDI footswitches send a library book.  In addition to sending any type of MIDI message(s) on any 

channel, library books can also control the MFC, such as changing bank and page. 

This footswitch is shown on the Effects menu because it has effect-type options (select, momentary or 

toggle).  They will often be used for extra effect switching options, but they can actually be used for any 

purpose.   

The default type of Send MIDI footswitch is "Select", which just means that it sends the selected library 

book messages each time you press the footswitch. 

You can also choose other footswitch types: 

 Momentary: press to turn on, release to turn off. 

 Toggle: press to turn on, press again to turn off.  A green LED shows when it is on.  Note that all 

Send MIDI footswitches are set to OFF when you select a patch. 

For these types of footswitches, the "on" book is the book number you select.  The "off" book is numbered 

1 higher.  For example, if you have a Send MIDI toggle footswitch set to send library book 5, the first press 

turns it on and sends book 5.  The second press to turn it off and sends library book 6. 

You can rearrange the order of library books on the Library tab with Move buttons, so use them to set the 

order you need. 

There are also 3 group options (red, green and yellow).  These indicate which footswitch was last selected 

in their group, using their group LED colour.  These are all select footswitch types, so they just send their 

library book messages when pressed.  



MIDI Tab 
 
This page now has a slider that allows you to make default and override settings.  Default settings should 
be the settings you most commonly use.  There are 7 override settings available as you move the slider to 
the right.  These can be used for different MIDI channels and/or MSB and LSB banks, and for different 
patch message types. 
 
On this tab and all others where you make override settings, they are only available for use, they are not 
yet active.  Go to the Overrides tab to set which overrides are used by which MFC patches. 
 
In Advanced mode, a MFC patch footswitch can send different types of messages: 
 

 A MIDI program change (PC) number.  This is the same as basic mode.  Patch numbers are set on 
the "MFC Patches" tab. 
 

 A library book number.  Library books are set up on the "Library" tab and can contain one or more 
MIDI messages as well as commands that control the MFC.  For Axe-FX owners, this could be used 
to select both a program and scene.  Non-Axe-FX owners can simulate Axe-FX scenes with library 
books that select patches with various effect on/off states.  Library book numbers are set on the 
"MFC Patches" tab and are limited to numbers 1 to 128. 
 

 A CC message, which has a CC number set on this "MIDI" tab, with the CC value (0 to 127) set on 
the "MFC Patches" tab for each patch.  This will be useful for Axe-FX owners who use scenes in a 
common way on different patches.  For example, scene 1 for clean, scene 2 for crunch, scene 3 for 
solo boost, etc.  By using overrides where some MFC patches send PCs and others send CCs you'll 
have a simple but powerful way to access many tones. 

 

A MFC patch selection typically does a lot more than just send one of the messages above.  It can set or 

reset all effect states, reset tap Effects, send additional messages, request Axe-FX information and more.  

Also your settings in the previous patch are retained, allowing you to use a Backtrack footswitch to switch 

between the last two patches used with their effect on/off settings. 

So even though you might only send a CC message to select an Axe-FX scene, the MFC treats it as if you 

have selected a new patch.  For that reason, if you're using scenes to turn Axe-FX effects off and on that 

are also controlled by the MFC, you will need to be careful with the patches initial effect states on the 

"MFC Patches" tab.  Alternatively, don't use the "Send initial effect state with patch change" option on the 

"Effects" tab for those effects.  You can still keep your MFC and Axe-FX effect states synchronised with the 

"Get Block States" option on the "MIDI" tab. 



 
 
 
 

 

 

MFC Patches Tab 
 
In advanced mode, this tab also shows an option "Allow reset for footswitches with 2 patches". 
 
By default (with this option checked) selecting the current patch when effect states have changed will reset 
effect changes.  Un-check this if you want footswitches with 2 patches to always toggle between patches 
and NOT reset effect changes. 
 
 
  



Effects Tab 
 
 
The differences for advanced effects are:  

 You can set up additional override effects available to be used 

 You can send library books which allow multiple MIDI messages on any channel, system exclusive 
messages, etc. 

 
 

 
 
 
Note that for a persistent effect to carry from one patch to another in advanced mode:  
 

 The effect must be set to "Persistent Toggle" (obviously) 

 The same effect must be using the same effect number (1 to 9) in both previous and current 
patches. They can both be the default effect, or they can both be the same overridden effect. 

  



Pedals Tab 
 
You can make override settings on the Pedals tab in Advanced mode.  Again, this just makes different 
settings available for use.  Go to the Overrides tab to set which MFC patches use which overrides. 
 
 

 
 
 
You can also set the pedal range on this tab, but it is strongly recommended to calibrate pedals on the MFC 
itself. However, if you happen to know their range, you can also set that in the editor and save these 
settings for loading into your MFC.   
 
When overriding pedal settings, you must use the same type of connected device (pedal controller or BS-2 
up/down footswitches).  For example, if your 2nd default pedal is a pedal controller, it can only be 
overridden by a pedal controller. 
 
Advanced mode also allows you to use a connected BS-2 to control Stepper #1 and Stepper #2. 

 

  



The Stepper 
 
There are two steppers available that each use up and down footswitches in Advanced Mode.  Use the 
Footswitches tab to assign Stepper Up & Down to footswitches, then use the Stepper tab to set up those 
footswitches. 
 
For example, a stepper can be used to step up and down through scenes on an Axe-FX, or it could switch 
between different volumes for several solo and rhythm levels. 
 
You can think of a Stepper as being like a control pedal with certain fixed values.  Instead of rocking a pedal 
back and forth, you use a footswitch for up and another footswitch for down. 
 
Stepper footswitches are assigned on the Footswitches tab and can be selected from the Effects sub-menu 
in Advanced Mode. 
 

 



Stepper Tab 
 
A Stepper Up/Down footswitch shows a red LED if it is at its limit, where pressing it again will make no 
difference, or wrap to the opposite limit if you use the wrap option.  Otherwise, the footswitches light 
green if the current value is between the starting value and its limit. 
 
The current Up/Down value is remembered for patch backtracking.  So if you are using effect backtracking, 

Up/Down effect values will be restored. 

On the Stepper tab, the slider selects which of the two Stepper effects to edit. 
 

 
 
Stepper effects can scroll through CC values or library book numbers. 
 
Lower and upper limits restrict up/down values within that range.  The upper limit can be set to a value 
less than the lower limit if you want to have reverse operation.  The editor will warn you if any settings are 
invalid. 
 
The step amount sets how much values change when you press up and down. 
 
The start value is set when you select a patch, and can optionally be sent with a patch change. 
 

  



Patch Select Tab 
 
This tab allows you to send additional messages when selecting a patch. You can send a CC or library book, 
or set relay states.   A single library book can send multiple messages including CCs, can also set relay 
states, and more. 
 
As always, use the default selection for the most commonly used settings (if any).  Then use the slider to 
select override settings for changes you may wish to apply to certain patches using the Overrides tab. 
 
  

 
 
 
Other options on this page allow you to: 

 Pause briefly after a patch change (which might be helpful with older MIDI equipment) 

 Go to a particular footswitch page after selecting a patch.  This will be ignored if you use an "and 
hold for page …" function on your patch selection footswitch. 

 Click [Patch Change Events] button set the order of various events that occur with a patch change. 
 
 

Overrides Tab 
 
Overrides are available when you select Advanced Options in the editor.  
 
  



Overrides give you the ability to change default settings to do something different, such as:  

 For patch B3, change the usual settings for effect 1 to a phaser and set pedal 2 to control whammy 
pitch 

 For all patches in bank C, set relays 1 and 2 both on, and send a system exclusive message 

 For patch D5, change all effect footswitches to something else, and send them on a different MIDI 
channel  

 For patches G2, H1 and J9, swap the positions of the overdrive and boost effect footswitches 
 
The first thing to notice is that on the MIDI, Effects, Pedals and Patch Select tabs, sliders give you the 
normal default settings at the left and override settings as you scroll further to the right. When you make 
override settings, they are available to be used, but will not be used until you select them on the Overrides 
tab. 
 
 

 
 
 
If the same patch is in more than one override, the last occurrence takes precedence.  This may be useful 
when you have an override set up for all patches in a bank, but you want one of them to have different (or 
no) overrides.  By placing the exception override last, it will be used.  The [Move] buttons can be used to 
change the order of overrides.  Otherwise, override numbers have no meaning in the editor; they're just 
numbered in order. 
 
These are very flexible and powerful options, so please take time to read the Override Tutorial for 
examples and more information.  
 



Library Tab 
 
Library books are available when you select Advanced Options in the editor.  
 
A Library book can contain one or more MIDI message of any kind, including System Exclusive, Patch 
Change, Continuous Controller, NRPN, etc. It can also include special commands to control the MFC, such 
as setting a bank, or short pause, and more.  
 
Library books can be used instead of CC messages for Effects, Up/Down footswitches, and for extra 
messages after a Patch Selection. They are entered as raw MIDI data, and there are several tools provided 
to enter common MIDI messages and values, and also MFC commands. 
 
1000 bytes are available for all Overrides and Library books.  Each library book has a maximum of 255 
message bytes, although you can use macros to chain books together.  There can be up to 250 library 
books. 
 

 
 
 
Click [Add Message] to add a new message, or select an existing book with the slider and click [Edit 
Message] to modify it.   You can use the [Move] buttons to arrange books into any order you wish. When 
you move and delete messages, the editor will update any library settings affected. 
 
The [Translate …] button shows a description of messages in each book.  See the Library Tutorial for 
examples and more information.  
 



Using the Emulator 
 
The emulator shows available 2nd footswitch functions in Advanced Mode.  However, you don't need to 
hold one function to get another in the emulator.  Simply click on the function you want to test. 
 
 

 
 
The Emulator doesn't use MIDI In, so it won't respond to an Axe-FX.  It is intended to allow you to test the 

functionality of your footswitch layout and to see the MIDI messages being sent. 

  



About Effects 
 

Where Are My IAs? 
 
IA is a term sometimes used for MIDI messages that toggle an effect on and off. There is no such thing as a 
MIDI "IA" message, so I use the correct term: CC for control change. This is also more applicable to my 
firmware that can send any value for off and on.  
 

Controlling Effect States 
 
Each patch has its own initial effect states so the MFC "knows" which effects to show as off and on when 
you select a patch.  That way you don't need to double-click some effects to get them synchronised with 
your connected device. 
 
Also, if you select a patch and then turn different effects off and on, the MFC patch LED flashes to indicate 
that if you select the current patch again, it will reset the patch to its initial state.  This is a handy way to 
quickly reset a patch that has had multiple effect changes.  There is more information later on how to fully 
or partially reset your patch effects with this method. 
 
Effect states are set like this:  

 If selecting a patch, any persistent effects will keep their off/on state from the previous patch, 
other effects will set their initial state set for the patch and send their off/on messages if set to 
"Send initial effect state with patch change ". 

 If backtracking with effects, all effect states (including Tap Effects, if used) will be set as they were 
in the backtracked patch. 

 
There are different ways to use these settings to control which effects are on and off when selecting a new 
patch. You can even use different methods for each effect.  
 
This MFC can fully control which effects are on and off when selecting a patch. To do this:  

 On the MFC Patches tab, set initial effect states for each patch however you want. 

 On the Effects tab check "Send initial effect state with patch change" for effects that you want to 
force off or on, to match their initial settings. 

 
There are many advantages to using the MFC to control your effect states (after all, it is a controller):  

 The MFC displays effects in their initial states when you select a patch. That way when you press an 
effect footswitch it will correctly turn the effect off or on. You won't have to press a footswitch 
twice to get it to synchronise with the way your patch is set. 

 The MFC "knows" what the normal effect states are, and indicates (with a flashing patch LED) when 
you've changed effect states. You can then press the patch footswitch again to instantly reset your 
patch. 

 There are no surprises playing live, even if you accidentally save a patch with the wrong effects off 
and on. Recalling them with the MFC will always set the effects that you want and expect. 

 You can set up several MFC patches with the same MIDI program, but with different effect states. 
This is similar to scenes on the Axe-FX, but you can have a very large number of them, with even 
more options in advanced mode. 

 
You don't need to set "Send initial effect state with patch change" for every effect, but those effect states 
will be set by your device when you change patches. 



 

Getting Effect States from the Axe-FX 
 
If you own an Axe-FX II, you can have the Axe-FX set effect states on the MFC. To do this:  

 On the Effects tab un-check "Send initial effect state with patch change" for all effects 

 Use effect CC values 0 for OFF and 127 for ON (you can use them oppositely if you wish) 

 On the MIDI tab, check "Get Block States" 
 
If you own an Axe-FX III, you can have the Axe-FX set effect states on the MFC. To do this:  

 On the Effects tab un-check "Send initial effect state with patch change" for all effects 

 Set the Axe-FX block that this effect controls 

 On the MIDI tab, check "Get Block States" 
 
This works for very basic on/off effects and may be all you need. The MFC will learn initial effect states as 
you use patches, so they don't even need to be set correctly in Patch settings. It will identify your and set it 
to off or on by looking for values 0 and 127.  
 
But there can be some disadvantages of this method. The Axe-FX only sends basic effect state information. 
It won't be able to show effect states on the MFC:  

 If you use a footswitch to toggle between different levels, such as OFF for a low ambient reverb 
level and ON for a higher "big reverb" level. In both cases the Reverb block is on, so the Axe-FX can't 
tell the MFC whether your "big reverb" reverb effect is off or on. 

 Some effects, such as the mixer, don't even have an off state, so there's no way to show any 
changes you might make with these effects. 

 You might use a footswitch to change settings in multiple effects, such as boosting delay feedback 
and also changing rotary speed. This type of effect modifier doesn't correspond to a simple on/off 
effect. 

 You might use a single footswitch to turn several effects off and on (or even turn some off while 
turning others on).  The Axe-FX can't reliably tell the MFC whether that effect is meant to be off or 
on. 

 An effect might change relay states and send system exclusive messages, so again, the effect 
information from the Axe-FX won't be able to tell the MFC what's off and on. 

 
To guarantee your Axe-FX and MFC effects are synchronised with patch changes: 

 Set their initial states for the patches you use on the "MFC Patches" tab 

 Set "Send initial effect state with patch change" for each effect on the "Effects" tab 
 
This method forces the Axe-FX to set effects off or on from your MFC settings. 
 

Why Can't I Choose CC Numbers 0 and 32? 
 
Well firstly, the MFC does send CC message numbers 0 and 32 - they're the MSB and LSB bank numbers on 
the MIDI tab. They are used to access more than 128 patches on connected equipment.  
 
CC numbers 0 and 32 are reserved for MIDI patch banks, so they're not available as effect controller 
numbers. Using those numbers for effect controllers can cause unpredictable patch selection in connected 
equipment. Any other number from 1 to 31 and 33 to 127 can be used.  
 

  



Tips 
 

Keep It Simple 
 
This firmware, particularly in Advanced mode, is capable of some very flexible footswitch options, message 

control and MFC operation.  But just because you can do nearly anything doesn't mean you should try to 

do everything.  I recommend using simple layouts that meet your basic needs, particularly if you use your 

MFC for live use.  This allows you to focus on the performance and presentation, instead of wondering how 

you got to page 3 and which button you need to hold down to go back  

 

Axe-FX Owners 
 
This section will help Axe-FX owners get the most from their unit with the GM Arts MFC firmware.  Also, 
the Axe-FX is able to do many of the same things that the MFC does, so it's important to choose one 
method or the other.  For example, both the MFC and the Axe-FX can automatically turn on delay effects 
when tap tempo is set, so you don't need to use both methods at the same time.  
 
Firstly, we need to make settings so that the MFC and your Axe-FX can "talk" to each other.  To do this 
you'll need to match some settings between both units.  
 
MIDI CHANNEL 
 
The MFC sets its MIDI channel on the Editor MIDI tab.  The Axe-FX sets MIDI channel here: 
 AXE-FX II:   I/O button > MIDI tab > MIDI Channel  
 AXE-FX III:   Setup > MIDI/Remote > General > GENERAL  > MIDI Channel  
 
AXE-FX BANKS 
 
While you're on the Editor MIDI page, you can also set the MIDI MSB Bank to choose the Axe-FX bank. Axe-
FX has banks A, B, C and so on, each with 128 patches. These banks correspond to MSB numbers 0, 1, 2, 
etc.  If necessary, you can use overrides in the Editor to allow any MFC patch to select any Axe-FX patch in 
any bank.  
 
DISPLAY OFFSET 
 
The MFC sets its MIDI program as 0-based or 1-based on the Editor MFC Patches tab. The Axe-FX sets this 
as display offset here: 
 AXE-FX II:  I/O button > MIDI tab > Display Offset  
 AXE-FX III:  Setup > MIDI/Remote > General > GENERAL  > Display Offset 
 
CC NUMBERS 
 
MFC sets CC numbers on the Effects tab. You need to match these to the Axe-FX effects that you want to 
control, and this is done here: 
 AXE-FX II:   I/O button > CTRL tab 
 AXE-FX III:  Setup > MIDI/Remote > Bypass 
 then scroll down to match effect block CC numbers to your MFC effects.  
 



CONTROLLERS & PATCH CHANGES 

You may use a pedal that you want to control an Axe-FX parameter such volume or wah. You might even 
have an effect that switches a setting between different values (such as switching between a small amount 
of reverb and a high reverb level). This is a 2 step process on the Axe-FX:  

1. Set your CC number to any one the External Controllers 
2. Attach a modifier to the Axe-FX setting you want to control, using the same External Controller 

 
When you attach a modifier using an external controller, there is an option to set Program Change Reset 
(PC RST) off or on.  

 PC RST = OFF keeps the setting from the previous patch. This is good for a volume pedal so you 
don't have any unexpected volume changes between patches. 

 PC RST = ON uses the saved setting from the Axe-FX patch. This is good to get consistent behaviour 
when you select a patch. 

 
The Axe-FX also allows you to attach a modifier (controlled by the MFC via an external controller) to effect 
block bypass parameters. Combined with the above options, this gives you a lot of flexibility in controlling 
effect states and whether they retain their settings from the previous patch or not. The MFC has similar 
options, so use either approach to make sure they're not working against each other.  
 
AXE-FX MODEL & SETTINGS 
 
All of the above settings make sure the MFC can send messages to your Axe-FX via MIDI OUT from the MFC 
connected to MIDI IN on the Axe-FX. If you wish to view information such as tuner and tap tempo from the 
Axe-FX MIDI OUT to the MFC MIDI IN, you will need to check the following settings.  
 
To get started, select your Axe-FX model from the dropdown list on the Editor MIDI tab.  
 
DISPLAYING THE TUNER & TAP TEMPO 
 
To display the Axe-FX tuner and/or Tap Tempo on the MFC, you will need to make sure those messages are 
being sent from your Axe-FX: 
 AXE-FX II:   I/O button > MIDI tab > Send Realtime SysEx 
 AXE-FX III:  Setup > MIDI/Remote > General > GENERAL > Set Realtime SysEx 
 
TAP EFFECTS AND AUTO-DELAY 
 
The MFC can switch on Tap Effects after a preset number of tap presses after a patch change. The number 
of presses is set on the Editor Effects page, and of course Tap Effect settings are also on the Effects page. 
You can disable tap Effects by setting the number of tap presses to "Off".  
 
The Axe-FX has a similar feature where it will set tap tempo here: 
 AXE-FX II:   Global button > Config tab > Tap Tempo 
 AXE-FX III:  Setup > Global > Global Settings > GENERAL > Tap Tempo 
 You can choose the "Last Two" tap presses or an "Average" of recent tap presses.  
 
Likewise, you can set the Axe-FX to automatically turn on delay effects when a tap tempo is set: 
 AXE-FX II only:  Tempo button > Auto Delay 
 
Using the MFC to control Tap Effects has an advantage in being able to turn on 2 (or more with library book 
messages) specific effects. You also have the ability to set CC values to have Tap Effects set effect levels 
and other parameters.  



 
The Axe-FX is simpler to set up and just turns on all delay effects in the patch. So just use the method that 
suits you best.  
 
SCENES AND SEAMLESS PATCH RESETS 
 
The MFC has a useful feature of flashing the patch LED when effects have been changed. This makes it easy 
to see when you can press the patch footswitch to reset the patch and is seamless, with no audio dropout 
or effect switching glitches.  
 
The Axe-FX has a feature of being able to select any scene in any patch by using custom mapping: 
 AXE-FX II:  I/O button > MIDI tab > Mapping Mode = CUSTOM 
 AXE-FX III:  Setup > MIDI/Remote > General > PC CONFIGURATION > PC Mapping 
then use the next 3 lines to set which MIDI program (Map From Preset) maps to which Axe-FX patch (Map 
To Preset) with which scene (Map To Scene). For example, you can set it so that if you send MIDI patch 
number 120, it will select scene 3 of patch 27.  
 
AXE-FX II only:  To get seamless resets using the Axe-FX's patch and scene mapping, you will need to make 
some settings that are not intuitive: 
      I/O button > MIDI tab > Ignore Redundant PC = ON 
      I/O button > MIDI tab > Scene Revert = ON 
 Scene Revert = ON recalls saved scene states between scene changes, and setting "Ignore Redundant PC" 
ON does NOT ignore redundant (repeated) PCs when Scene Revert is ON.  
 
REVERB & DELAY TRAILS 
 
This tip really has nothing to do with the MFC. It's just general advice that if you want natural reverb and 
delay trails when switching them off and on, you should use the Axe-FX bypass option that turns their 
INPUT off and on. Likewise, a volume pedal should be placed BEFORE these effects for the same reason.  
 

Axe-FX Scenes and Effect States 

 
There are different approaches to using the MFC to select scenes: 

METHOD ADVANTAGES DISADVANTAGES 

Use some effect footswitches with the scene CC number (34 
by default), with no OFF value, and an ON value of 0 to 7 for 
scenes 1 to 8.  They should be set as a "Select" type and in 
the same group number.  

This is the simplest method 
and works in basic mode. 

It uses up some effect 
footswitches that you 
might otherwise use for 
effect blocks. 

Use a stepper in Advanced mode.  This could just send 
Scene CC values, or for the Axe-FX III, use library books to 
set a scene as well as request the scene name. 

Simple, only uses 2 
footswitches. 

Only allows stepping up 
and down through 
scene numbers. 

Use "MIDI Send" footswitches in Advanced mode.  Put them 
in the same select group.  Details are below. 

This method gives you a set 
of dedicated scene 
selection footswitches. 

Need to set up a library 
book for each scene 
you need. 

In Advanced mode on the MIDI tab, use the "Patch numbers 
are CC values" option.  This method allows you to treat 
scene selections as patch changes.  Using overrides, you can 
even use both patch and scene selections with your MFC 
patch footswitches. 

This method can send 
additional resets after 
patch selection and allows 
both Axe-FX preset and 
scene backtracking. 

Need to take care 
about which effects are 
reset with patch 
selection, and 
synchronising Axe-FX 
effect block states with 
the MFC. 



SCENE SELECTION WITH MIDI SEND FOOTSWITCHES 

 
Several features can be combined to allow you to use Axe-FX and scenes and effects toggles at the same 

time: 

1. Set up your effects and Tap footswitches as normal, and assign them to footswitches.  Effects 

should not use the option: "Send initial effect state with patch selection". 

2. Set up library books to select the scenes you wish to use.  By default these use CC number 34 with 

values 0 to 7 for scenes 1 to 8.  After the CC message, add a command to get Axe-FX block states.  

This will keep effects states synchronised between the Axe-FX and MFC.  For the Axe-FX III, you 

could also add a command to request the scene name. 

3. Assign Send MIDI commands to footswitches to select these scenes.  These footswitches should all 

be in the same Send MIDI group, for example, the yellow group. 

4. When you change patches, normally this also sets a particular scene number.  So set up another 

library book with a command to set the Effect LED for the Send MIDI group (yellow) with that scene 

number. 

5. On the "Patch Select" tab, set the library book number to the book you set up in step 4. 

Now, when you select a scene, your effects will be updated to reflect the new scene states.  You won't 

need to double-press effect footswitches to get them synchronised. 

Also, your scene footswitches will show a LED for the currently selected scene.  When you select a new 

patch, scene 1 LED will also show. 

 

 

Working with Multiple Devices 
 

 
 
 
This firmware is mainly intended to work with a single connected device.  However, it is possible to work 
with more than one connected device with a little planning.  Here are 3 methods: 
 
(1) Multiple Devices on the Same MIDI Channel 
 
For this method, set your devices to receive on the same MIDI channel that your MFC is using.  Patch 
changes will affect all devices and in many cases you will be able to use effect CC numbers that are only 
recognised by the intended device. 
 
(2) Using Library Books for Effects 



 
Effects can send library book messages instead of CC messages.  A library book can contain one or more 
MIDI messages, including patch change and CC (effect) messages on ANY channel.  So you can set up your 
library books to address each device individually.  If you're using effects to send patch change messages, 
you will want to set the effect type as "Select" and put them in the same group number.  That way, the 
MFC will display a single LED for the current patch. 
 
(3) Using Overrides 
 
You can use overrides for different MFC patches to have the MFC send on a different MIDI channel, and 
optionally use different MIDI MSB and LSB bank numbers.  That way, different MFC patches can address 
devices individually. 
 

Notes 

 

Bugs 
 
There are no known bugs with the settings I use, and all features have been tested individually. But with so 
many possible setting combinations it is not possible to test every scenario. I'm keen to make sure the 
firmware and editor work as described, so please let me know if you find any problems at info@gmarts.org 
 

Disclaimer 
 
GM Arts takes no responsibility whatsoever for the use or attempted use of the editor or firmware. 
 

Purchase 
 
The GM Arts Firmware and Editor are provided free of charge. 
 
BJ Devices MIDI Foot Controllers can be purchased from http://www.bjdevices.com/en/ 
 

mailto:info@gmarts.org
http://www.bjdevices.com/en/

